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Introduction

Introduction
Welcome
This Getting Started Guide provides you with an overview of GibbsCAM, its use and interface. A lot
of general information about the software is discussed in this document. As such, we highly
recommend that you review this material before moving on to more specific topics such as
Geometry Creation, Advanced CS, SolidSurfacer or MTM.

About The System
Please be advised that GibbsCAM security is activated via the Internet. If you do not have Internet
access available, you may activate security via e-mail or regular mail.
Please allow adequate time to have the license file sent to you.
Method

Estimated time

E-mail during Gibbs business hours

Same business day if received before 2:00 PST

E-mail after hours

Next business day

Regular mail

1-2 business days plus regular mail delivery time

About Getting Started
This document is designed to give you both a quick start to using GibbsCAM and also a more
detailed overview of the system in general. Whether you want to jump right into using the software
or read the manuals cover to cover, this book can be of great help.
Among the contents of the book are:
•

Interface : Explains all of the common elements of the system. It does not matter whether you
are a new user or a seasoned power user, this section will help you get acquainted with
GibbsCAM and its many changes. It will help you understand the software and might answer
the question, “What am I looking at?”

•

Quick Start which introduces the process or steps to using GibbsCAM. This can be thought of
as an overview of using GibbsCAM.

•

Using the System which goes into greater detail than the Overview does.: Goes through the
process of making a part from start to finish. You will still want to read the individual product
guides for the greatest understanding of a particular product, but this section will give you a
head start.
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•

Appendix: Includes a Glossary of terms used in GibbsCAM and in the industry. You might want
to look through the glossary to learn whether we are speaking the same language. The
Appendix also includes answers to frequently asked questions.

Contacting 3D Systems GibbsCAM
Technical Support is available to all users. Our Technical Support department is available to
answer your questions Monday through Friday, 5:00AM to 5:00PM Pacific Time.
Telephone:

l
l

Fax:

l
l

E-Mail:

l
l
l

(800) 654-9399
+1.805.523.0004
+1.805.523.0006
GibbsCAM.Support@3DSystems.com
GibbsCAM.Registration@3DSystems.com
GibbsCAM.Sales@3DSystems.com
GibbsCAM.Info@3DSystems.com

When contacting the Technical Support department, it is helpful if you know the following
information. Version information is found by selecting the About item from the Help menu of your
GibbsCAM application.
•

Type of computer

•

CPU speed and memory (RAM)

•

Operating system

•

Version of GibbsCAM software
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GibbsCAM on the Web
For more information and help, find us on the World Wide Web:

http://www.GibbsCAM.com
The Official GibbsCAM website.

http://forums.GibbsCAM.com/
GibbsCAM support forums.
www.gibbscam.com/supports/gibbscam-training
For GibbsCAM training videos
http://support.GibbsCAM.com/
Manage your Trouble Tickets or search the GibbsCAM Knowledgebase for a
solution

http://www.facebook.com/gibbscam
GibbsCAM is on Facebook

http://www.youtube.com/user/gibbscam1/videos
Product videos and information

http://twitter.com/gibbscam
Follow us on Twitter

Other useful contacts:

http://www.machininginfo.com/gibbs_menu.html
External website that provides training videos for GibbsCAM.
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http://www.autodesk.com/inventor
External website that provides more information on Autodesk Inventor products.
http://www.Volumill.com
External website that provides more information on VoluMill Ultra HighPerformance Toolpath (UHPT) from Celeritive Technologies.
http://www.predator-software.com
External website that provides more information on a CNC editor and a virtual
CNC viewer from Predator Software, Inc.
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Interface
About the Software
GibbsCAM supports Windows 10, is compatible with Windows 8 and Windows 7, and certified for
Windows Vista. This means, among other things, we follow user account control guidelines,
support x64 Versions of Windows and support concurrent user sessions. GibbsCAM no longer
supports 32-Bit Windows. Application and document icons comply with Windows 7 user interface
guidelines.

Other features include:
•

Multiple monitor support

•

Dynamically resizable window

•

Copy and Paste of data between parts and sessions

•

Unbound Dialogs — dialogs can be placed outside of the application window

•

Window snap — windows and dialogs will snap into position when near each other. This also
applies to resizing dialogs.

•

Roll-up — windows can be made to compress to only display the title bar, and uncompress when
activated by the mouse

•

Windows can have transparency

•

Memory of where windows were placed, per user

OpenGL® is integrated into the software. OpenGL is a 3D library that provides the system with fast
hardware accelerated rendering for, high quality rendering, true color display, material properties,
advanced light sources, user-definable colors, animated view transitions, shadows, transparent
planes and user-defined OpenGL configurations. All of this translates to improved display quality
and more user control and customization.
The GibbsCAM software has two interface levels. Level 1 Interface is deliberately clear and
uncluttered but still displays the Main menu, Tool, Process and Operation Lists and toolpath.
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1.
2.
3.
4.
5.
6.
7.

Main Menu
Pull-down menu
Command Toolbar
Tool List
Workspace
Geometry
Palette with WG
info
8. View Control
palette
9. Trashcan

The Level 1 Interface.
The Level 2 interface is the most advanced interface. It is recommended that most users work in
this interface level as it is optimized for accessibility and power. Every capability of the system is
available from the Level 2 interface. Level 1 only contains subsets of the features in level 2.

1.
2.
3.
4.
5.
6.
7.
8.

The Level 2 Interface with some elements also available in Level 1.
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Command Toolbar
Floating Toolbar
Workgroup List
Coordinate
System List
Process List
Machining
Toolpath
Operations List

Quick Start

Quick Start
GibbsCAM software is easy to use. Here, we provide a quick overview of the process from part
creation to completion. Although GibbsCAM imposes no set sequence to creating a part, some
things precede others. For example, you must have a file to work on before you can make a part; a
Tool list must be defined before toolpath can be generated. However, once you have done
something in the system, you can change something (like a tool or stock condition) and effortlessly
update the entire part. Here are general guidelines for creating a part.

Basic Steps for Using the System
There are five basic steps to using GibbsCAM.
l
l
l
l
l

1. Create or Open a Part File
2. Make or Modify a Model on page 13
3. Create Operations on page 13
4. Render the Part on page 14
5. Post the Part on page 15

1. Create or Open a Part File
You can either create a new part file or open an existing model. This is often done with the
Document Control dialog (DCD), whose icon is in the Command Toolbar at the top left of the
workspace. The DCD provides controls for file management, part measurements, comments and
preferences, stock setup, and the like. For more information, see “Setting Up A Part - The
Document Control Dialog ” on page 21.

DCD (Document Control dialog) for a Turning part
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2. Make or Modify a Model
Next, you need to make a model of your part, or to modify an existing model. Modeling is
accomplished with the Geometry Creation Palette , with Solid Modeling , or a combination of
the two. For more information see the Common Reference and Geometry Creation guides.

Part Models: Geometry and a Solid

3. Create Operations
Once a model is created, you apply machining functions to the part. This includes setting the
available tools , defining processes, and creating operations . Creating tools can be done at
any time when a part file is open. Processes and operations are created after tools are defined. For
more information, see the Common Reference, Mill, and Turning guides.
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A Tool, a Process, and Resulting Toolpath

4. Render the Part
Once operations have been defined for machining a part, the part should be rendered. This
provides a visual check of the part to ensure that the results are as expected.
Many errors can be caught using Cut Part Rendering (CPR) or Simulation. It can also be very
useful to run the rendering as you create operations, rather than after you are finished and are
about to post the part. For more information, see the Common Reference guide.

Cut Part Rendering (CPR) Is Run on a Part
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5. Post the Part
The last step is to generate the output from the part file and create NC-code. This is called Post
Processing. For more information, see “Posting Step-By-Step ” on page 65.

Posting a Part
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Using the System
The following sections provide a more detailed description of your GibbsCAM software. This
includes
Launching the System, next
Opening or Creating a Part
Geometry Creation,
Tool Creation,
Creating a Process ,
Operations,
Post Processing .

Launching the System
GibbsCAM products can be launched in several ways.
l

Launch the application through a desktop shortcut.
The installer creates a desktop shortcut. This is the easiest way to start the software.

l

Use the Start menu to launch the application.
Click the Start menu, go to All Programs, then the GibbsCAM folder, then GibbsCAM v14.
Click the mouse button again to launch the program.

l

Double-click a part file.
Double-clicking a part file will also launch the system.

l

Windows Search Bar.
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Using the Start Search feature in Windows to start an application
This is perhaps the easiest method if you are unable to locate the application shortcut. Open the
Start menu and start typing the application name, for example “gi”, and a list of files and programs
instantly appear that begin with those letters allowing you to select the exact item you are searching
for.

Opening or Creating a Part
There are four ways to create a new part or open an existing part.
1. From the File menu select New or Open.

2. Open the Document Control dialog by clicking on the Document button
Toolbar.

in the Command

The top section of the Document Control dialog has buttons for creating a new part (New ) or
opening an existing part (Open).
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3. Press Ctrl+N or Ctrl+O on the keyboard.
Pressing Ctrl+N will create a new part. Pressing Ctrl+O will bring up the Open dialog. Learning
the system’s keyboard shortcuts can be a great time saver.
4. Drag and drop a file icon onto the application window or a desktop shortcut.

Opening Parts
When the Open command is selected, the Open part file dialog will appear. The initial location is “My
Documents” or the directory that was last used when opening a part. The dialog displays a picture
of selected VNC files and provides some basic information about the part, such as its size and
material.
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The Open dialog will only display files of the type you tell it to look for. By default this setting is VNC
files, the native file type for GibbsCAM files. To change the file type, click on the Files of type pulldown menu. This will display the types of files you may directly open. Please note that this changes
with the options you have purchased.
Optional ways of opening a part are: double-clicking a part file and dragging and dropping in
the workspace or a shortcut icon.

Creating New Part Files
When one of the three methods of creating a new part has been selected, a dialog will come up.
This allows you to give the new file a name and select where it should be saved. Enter the name of
the part in the File Name text box and navigate to where the file should be saved. Click on Save.
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Now that a new part file has been created, the part must be set up. The units of measurement,
stock size, type of part and clearances must be set. This is accomplished through the Document
Control dialog (DCD). For more information on the DCD, see Setting Up A Part - The Document
Control Dialog .

Importing Part Models

Importing allows an existing saved part to be added to a current part. The current part file may be
new, with no tools or geometry or the part may be an existing part full of geometry, solids, tools and
operations. Using the Import function is a good way to merge two similar parts or add fixtures and
jigs.
To import a model into the part file click on the File >
Import… option in the main Menu. The
Import file dialog appears, allowing navigation to the file being imported. Choose the directory that
the file is in and change the Files type choice to the type of file that is being imported. When the file is
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shown in the list, double-click it or choose Open. This will bring the existing part and its settings into
the Workspace.
The Import dialog will only display files of the type you tell it to look for. To change the file type, click
on the pull-down menu. This will display the types of files you may directly import. Please note that
this changes with the options you have purchased.

Setting Up A Part - The Document Control Dialog
Setting up a part refers to defining the units of measurement and size of the part, the type of
machine that will cut the part, the material the part will be made from and setting the part’s
clearances. All of this data is entered in or selected from the Document Control dialog (DCD). The
DCD is accessed by clicking on the Document button in the Commands palette.
The lower part of the dialog differs according to machine type and other factors. It is discussed in
more detail in the guides for Mill and Turning.
1. Comments Tab
2. Machining Preferences Tab
3. Machine Setup tab: see the
Mill guide.
4. Machine Type
5. File Control buttons
6. Materials: see the Common
Reference guide.
7. Unit of Measurement
8. Workspace tab: see the Mill
guide.
9. Multi-Part tab: see the Mill or
TMS guide.
10. Interop Positions ; see below.
11. Intermediate Tooling tab: see
the Common Reference
guide.
12. Stock size and Origin
13. Tool Holder Basics
14. Clearance Plane
15. Indicates whether the Tool
Change checkbox is selected
Document Control dialog for a generic 4-axis vertical mill
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1. Comments Tab
2. Machining Preferences tab:
see the Common Reference
guide.
3. Machine Type
4. File Control buttons
5. Materials: see the Common
Reference guide.
6. Unit of Measurement
7. Interop Positions
8. Intermediate Tooling tab: see
the Common Reference
guide.
9. Workspace tab: see the
Turning guide.
10. Tool Holder Basics
11. Radius or Diameter display
12. Clearance Plane
13. Fixed Clearance positions

Document Control dialog for a generic horizontal lathe

Top half of DCD dialog
General Tab
Machine Type
Click to open the Machine pull-down menu which lists all the available types of machines. This may
include 2- and 3-axis lathes and 3-, 4- or 5-axis mills, both horizontal and vertical. The actual
contents of the menu will vary depending on the options installed. Select the type of machine that
will be used to cut your part.
File Control buttons
This set of buttons provides access to creating a new part, opening and closing an existing part, and
saving the current part. The part may be saved under a different name or location by selecting Save
As . A copy of the part may also be saved using the Save Copy button. Save Copy will append “copy” to
the file name so the original and copy can be saved in the same folder. You can use Save Copy to
save a part to an older version of GibbsCAM. Select the version you wish to save the part in, from
the Save As Type pull-down menu.
Part Material
The material the part will be cut from may be selected here. A database of materials and
recommended cut speeds and feeds for each entry can be created or edited here. There is also the
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option of purchasing CutDATA™ material library. For more information on Materials, see the
Common Reference guide.
Unit of Measurement
Select whether the part will be defined in inches or millimeters. This setting may be changed at any
time but any existing geometry, tools and operations will have to be updated to match the change.
Please note that solids will automatically scale to match the part. This does not affect posted data as
post processors are either inch or metric and will convert values as needed. Also, solids and sheets
are unaffected by changing the measurement units. Tools of either unit can be created.

Comments Tab
Any text entered as a part comment will be shown in the part preview of the Open dialog and will
appear in posted output. An unlimited number of plaintext Unicode characters can be entered. The
user is responsible for ensuring that this field contains only post-compatible characters.

Machining Preferences Tab
Spline Machining Tolerance
This is the curve height accuracy used when machining splines/curves or when using 2D Form
or 3D Form tools. Curves are machined as a series of small straight lines. This value is the
maximum amount these lines may deviate from the true curve.

Important: The value for Spline Machining Tolerance is used by 2D Form tools and 3D Form tools,
which typically use free-form curves (spline geometry) in their construction.
Entry Line Approach
Used when specifying an entry line and arc for Contouring or Pocketing. Tangent Entry Line to Arc
keeps the line tangent to arc. Normal entry line to Arc keeps line perpendicular to arc recommended if you prefer CRC from tool edge. Line length should be greater than or equal to
tool radius.
Mill/Turning CRC Type
Select Toolpath type for Ops. In Tool Center, the toolpath is calculated to tool centerline,
including any stock allowances. For Tool Edge, toolpath is to the tool edge, including stock
allowance. For Finish Profile, toolpath is at finish geometry and does not include stock.
CRC Entry Line Validation
When checked, this will enable the validation check for the CRC entry line. The check will
determine if the CRC entry line is greater than zero in length.
Omit Small Chord Arcs
When this checkbox is selected, toolpath arcs that are nearly identical (specifically, arcs whose
chord height from a line with the same end point is less than 0.0001 inches) will be output as a
single line move.
Oriented Toolpath
Affects operations that use the Multiple Orientations checkbox in the Linear Broaching process
dialog. When part and tool rotate with respect to each other and the tool must move to arrive at
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the next broach position, you can specify when the tool rotates to the needed orientation for the
next broach. For complete information, see the Broaching guide.
-

Before the move:

Is supported on all machines. Tool and/or part rotate to the correct orientation and then
move to the correct position.
-

With the move:

Is the fastest of the options, but it requires a type of interpolation that is not supported on all
machines. Tool and/or part move and rotate simultaneously.
-

After the move:

Is supported on all machines. Tool and/or part move to the correct position and then rotate
to the correct orientation.
Use Global Settings for Solids
When checked, applies default tolerances to machining processes. These settings can be
overridden for specific operations using the Advanced Settings option in the process dialogs.
Part Rough Tolerance
When Tolerance:Rough is selected in a process dialog, this value is used for the machining
tolerance. This value is also used for the stock tolerance.
Part Finish Tolerance
When Tolerance:Finish is selected in a process dialog, this value is used for the machining
tolerance. This value is also used for the stock tolerance.
Fixture Tolerance
This value is the tolerance used if toolpath encounters a body designated as a fixture. The
tolerance is applied to the clearance tolerance value.
Fixture Clearance
This is a clearance tolerance applied to fixtures encountered when creating toolpath.

Machine Setup
This option only appears for Milling machines and is discussed in more detail in the Mill guide.

Bottom half of DCD dialog
Workspace (Mill or Lathe) Tab
For more details on this tab, see the Mill or Turning guides.
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Mill stock

Lathe stock

Multi-Part Tab
For more details on this, see the Mill or TMS guides.

Interop Positions
For any generic MDD, or for any custom MDD that specifies a Flow Axis Set (FAS) with an Interop
Event Location whose axes are set to User, the Interop Positions page lets you decide whether or
not to specify tool change positions for parkable axes.
Additional controls are offered, depending on settings in the MDD.
•

If the MDD's Machining Preferences page has Show Tool Change Check Box selected, then the
DCD's Interop Positions page will offer a Tool Change checkbox. Selecting this checkbox
displays an Axis / Value table that allows you to specify the tool change position for each listed
axis.
Note that for a radial axis, such as the X in a simple XZ lathe, the value you supply is a radial
tool change position, not a diameter value.

•

If the MDD's Machining Preferences page has the Force Share User Axis Values checkbox
selected, then the Axis / Value table will cause the specified values to be shared automatically
across all matching axes in each Flow Axis Set (FAS).

•

If the MDD does not force sharing of user axis values, then the end user has control:
-

If you select the Share User Axis Values checkbox, the values you specify are shared across
all axes in every FAS, as noted above.

-

If you deselect this checkbox, then a pull-down menu appears that allows you to set user
axis values for each FAS Interop Event Location.

In addition to specifying the position of the turret when tools are changed, the Document dialog
provides the user with two options for handling part clearance: Auto Clearance or Fixed Clearance. The
selection made will determine how the system will calculate positioning moves between operations.
This enables you to set tool change positions.
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Intermediate Tooling Tab
Enables detailed setup of toolblocks and fixtures. In the Common Reference guide, see the section
on Intermediate Tooling.

Default Type and MDD Parts

Default settings and prepared tool lists may be automatically applied when creating a new part. This
includes information such as tools, processes, operations, geometry and custom stock. This
capability works for Machine Types and MDD’s (Machine Definition Documents). An MDD must be
available for each machine that will be used within Gibbs. This is because each machine has
different parameters and abilities.
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To enable Defaults for machine types or MDD’s, create a new part with the desired machine type or
MDD with the tools, stock and other settings and choose File >
Type Default Part or
MDD
Default Part. You can override these defaults by resaving the default type or MDD. Once a default
is created, each time a new file is created it will have the very same data as the default file.

Switching Between Defaults
The default settings are determined by the current MDD selection in the Document Control dialog.
Close any open part files and choose a machine type from the MDD list and create a new part to
apply the defaults for a different MDD.

Geometry Creation
For more comprehensive information about Geometry Creation, see the Geometry Creation Guide.
The following provide a general overview of creating geometry within GibbsCAM.
Geometry Palette,
Connecting Geometry,
Workgroups,
Coordinate Systems.
Creation of 3D Bodies

Geometry Palette
To create and modify geometry, you use the Geometry Creation palette. The Geometry Creation
palette has seven buttons that lead to sub-palettes for creating geometry, one button that connects
and disconnects geometry and one button that leads to a dialog—the Geometry Expert. Each subpalette contains a set of buttons that display a dialog or perform a function.
1.
2.
3.
4.

Points button
Lines button
Circles button
AutoShapes button

5.
6.
7.
8.
9.

Splines button
Chamfer/Fillet
Geo From Solids
Connect/Disconnect
Geometry Expert

The Geometry Creation palette
Geometry is essential to machining a part. Without it, there is nothing to machine unless you have
the SolidSurfacer option. Points are used for drilling, tapping and thread milling. Lines and circles
are used for roughing, pocketing and contouring.
You can create geometry in four ways:
l
l

Text input through a dialog,
Copy and paste from existing geometry,
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l

l

Draw by hand with a mouse or a digitizing tablet. You can only create lines and points by
hand, other features require dialog input.
Imported from a file.

You can combine geometric features into complex shapes. Shapes can be “open” or “closed.” A
closed shape is a shape that has no discernible end, such as a rectangle. An open shape has ends
and does not connect to itself. An example is three sides of a rectangle or a line connected to an arc.

An example of a closed shape and an open shape
To connect two features, such as a line and a circle, a point must be created where the features
intersect. The point is referred to as a connector. Points are also referred to as terminators, or
terminating points in some cases. The points at the ends of an open shape are referred to as
terminators.

Creating Geometry
There are three basic types of dialog input for geometry. First is the entry of specific coordinates in
text boxes. Second is the selection of a specific feature to be used as a reference, such as tangent
to a circle or a point. Third is specifying the dimensions and location of a final shape, such as a
rectangle.

The three basic types of geometry dialogs
Once a dialog has enough information to create the type of feature specified, the Do It or single
feature button will become available. Click on the button or hit Enter on your keyboard to create the
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feature. Shape dialogs will remain open after a feature is created while the palette will return to the
Geometry Creation palette unless the multiple feature button is clicked.
An unseen function of the Geometry Creation palette is its ability to create geometry without having
data entered into dialogs. If geometry in the Workspace is selected and provides enough
information to define a feature, clicking on that feature in the geometry creation palette will open the
appropriate creation dialog. For example, selecting three points in the Workspace and clicking on
the Circle button in the Geometry Creation dialog will open the Three Features Circle sub-palette
with all of the data loaded and ready to be created.

Connecting Geometry
The following figure illustrates how geometry is connected.
1. To begin with there are just two unconnected lines, one vertical, one horizontal. Both lines are
unterminated.
2. A connecting point is then added by selecting both lines, then clicking on the
Connect/Disconnect button. The lines are still unterminated but connected.
3. A circle is then added.
4. In the fourth image, the circle and horizontal line are selected then clicking the
Connect/Disconnect button. A connecting point is added to connect the circle to the horizontal
line, and the line is terminated.
5. The circle is then connected to the vertical line and a closed shape is created. A closed shape
has no start or end point and effectively creates a loop of some shape.
6. In the sixth image, the vertical line is deleted and the connecting points are changed to
terminating points by clicking on the Connect/Disconnect button. For more information see the
Geometry Creation guide.
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1

2

3
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Example of Connecting and Terminating Geometry

Workgroups
Workgroups are separate layers used to separate different groups of geometry, including custom
stock. This can be of great help in keeping the Workspace uncluttered. While the geometry for more
than one workgroup may be viewed, only the geometry in the current workgroup may be modified.
All geometry created will be in the current workgroup. Geometry in background workgroups will be
colored gray and cannot be selected.

Level 1 Interface
Workgroups are accessed through the Geometry Creation palette. There are two buttons on the
top right-hand corner of the palette. The left button opens the workgroup list, and the right button
brings up the workgroup dialog to quickly switch the current workgroup.
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Level 2 Interface
Workgroups are accessed from the Command Toolbar. If you click the top of the Workgroup
command the Workgroup dialog opens (Below left). Clicking the down arrow opens a quick
selection list (Below right).

Workgroup List

When a new part is created, there is only one Workgroup. Add more Workgroups by clicking New
WG. The current Workgroup is highlighted in blue. Clicking a column title in the workgroup dialog will
sort the Workgroup display.
The Workgroup dialog has four columns: Workgroup number; Eye status display; (Show/hide
Workgroup) Comment; and Type.

Workgroup dialog Right Mouse Menu
You can right-click the Workgroup title bar or a Workgroup list entry to open a context menu.
This contains actions that are commonly used with workgroups:
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WG Info
The WG Info choice opens a dialog that allows you to specify the behavior of geometry in this
workgroup:

Workgroup Info dialog for Mill part
Workgroup Info dialog for Turning part
Choose Part Stock to use the geometry as a stock shape, or choose Part Geometry to specify that
geometry in the workgroup is used to define the part.
Part Stock
If Part Stock is selected, the geometry in the workgroup will be used for any calculations that
need to look at the stock dimensions, such as Auto Clearance and Material Only. The geometry
can be used as the starting stock condition in rendering and simulation, so long as it is a closed
shape. When used in this way, the stock shape can also be used in machining operations to
adjust the toolpath according to the amount of material to be removed based on the stock
shape.
Extruded geometry in Turning workgroups is extruded along the depth.
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Coordinate Systems
A coordinate system is a plane in space with an origin and three axes. Examples of different
coordinate systems are the XY, XZ and YZ planes. In addition to these primary planes, there are a
limitless amount of other planes that may be defined. Geometry can be defined using these other
planes with the Advanced CS module. The following image is an example of three different
coordinate systems. The circle in each coordinate system is at the same horizontal, vertical and
depth position relative to each coordinate system.

Geometry is not contained in a coordinate system the way it is with workgroups. The coordinate
system used to define geometry. It can be thought of as an attribute of the geometry and its
orientation to the rest of the part. Geometry can be moved in and out of coordinate systems as
needed.
Coordinate systems are used for 3D geometry creation, rotary part orientation for machining,
multiple work fixture offsets, and as a basis for solid modeling. Fully understanding coordinate
systems is vital to using the Advanced CS and SolidSurfacer modules. Coordinate systems are
only available in the Level 2 interface.

Coordinate System List

Similar to the Workgroup list is the Coordinate System list. The Coordinate System list provides
access to controlling the coordinate systems. When a new part is made there is only one coordinate
system in the list: the XY plane for mill parts and the XZ plane for turning parts. Additional
coordinate systems are created by clicking on New CS. The current coordinate system is highlighted.
The “eyes” on the left side of the list show and hide the coordinate systems. The name of the CS
may be changed by clicking on the entry in the Comment column. The CS list also contains entries
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for specifying the spindle to which the CS is assigned (MTM only) and specifying the Work Fixture
Offset to which the CS maps (requires Advanced CS). Clicking on column title will sort the CS list.

Coordinate System Palette
When a coordinate system is created, it is automatically made to be identical to the current
coordinate system. The coordinate system palette allows you to redefine the new coordinate
system’s orientation, change its origin, toggle its depth axis or quickly align it to one of the primary
planes.

Creation of 3D Bodies
Three dimensional bodies, either solid bodies or sheet bodies, may be used in addition to or in place
of geometry for a part model. The process of solid modeling involves using graphically disjunct
objects (solids and sheets) and combining, modifying and manipulating them to create the final part
model. The process of solid modeling starts with the creation of a simple body referred to as an
atomic or primitive body. Examples of an atomic body include a sphere, a cube, a revolved or
extruded 2D shape, etc.
The basic operations, often referred to as Boolean operations, are to add, subtract or intersect
these simple bodies to create a new, distinct body. Each time a Boolean operation is performed the
result is always a single object. In this way, solid modeling allows the user to work with single
objects rather than hundreds of surfaces.
Solid modeling capabilities are accessed through the Solid Modeling icon in the Command Toolbar.
Clicking this button brings up a palette that contains the basic Boolean functions and buttons to
open the two solids sub-palettes. The two sub-palettes are the Create Solid palette and the Advanced
Solid Modeling palette.
1.
2.
3.
4.
5.

Create Solid
Advanced Models
Slice
Swap
Replace

6.
7.
8.
9.

Add
Subtract
Intersection
Separate

The solids sub-palettes provide access to the creation of primitive solid bodies and the modification
of primitive bodies. A primitive body is an original solid, created from a geometry profile or text input
in a dialog describing the solid. Primitive bodies are the basis for creating solid models. The
functions to create a primitive solid are found in the Create Solid palette.
1.
2.
3.
4.

Sphere
Cuboid
Extrude
Revolve
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5. Loft
6. Sweep
7. Solidify
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The Advanced Solid Modeling palette provides access to non-basic Boolean functions that may be
applied to bodies. This includes rounding corners and offsetting or shelling a body.
1.
2.
3.
4.

Offset/Shell
Round Corner
Unstitch Body/Heal
Draft

Surfaces can also be created by the 3D modeler. The modeler creates an object called a
sheet. A sheet is similar to a solid body in that it is made up of faces. A face is a single surface.
However, a sheet does not have any volume the way a solid does. A sheet is only made up of faces,
whereas a solid is composed of the faces as well as the space enclosed by the faces. One way to
think of it is that a sheet is similar to an infinitely thin gauge balloon while a solid body is more like a
bowling ball.
1.
2.
3.
4.
5.

Plane
Revolve
Loft
Coons Patch
Sweep

6. Sheet From Face
7. Trim / Un-Trim
8. Stitch
9. Unstitch
10. Untrim & Extend Surface

Creating Solids Example
The following three images show a very simple example of making a solid beyond primitive bodies.
In the first image we have a simple cube made from the Cuboid button in the Create Solid palette.
The second image shows four primitive bodies, two spheres and two tapered extrusions. The
spheres were created from the Sphere button (also found in the Create Solid palette). The tapered
extrusions were created from the Extrude button in the Create Solid palette along with selected
geometry. The selected geometry provided the filleted corner shape to apply the extrusion to. The
third image shows the result of subtracting the spheres and extrusions from the cuboid. The
Subtraction button found in the Solid Modeling palette was used for this operation.

Example of making a solid model beyond primitive bodies.
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Workgroups and Coordinate Systems in Solids

Solids and sheets are not contained in workgroups. They are either drawn in the Workspace or
placed in the Body Bag. The Body Bag is a small window where bodies are stored to minimize
clutter. Bodies are assigned a coordinate system based on the current CS when the body was
created. Some of the modeling functions such as extrusions and revolved bodies are CS-specific,
meaning that the current coordinate system is used to create the body. Other modeling functions,
such as lofting, are not dependent on the current CS.

Tool Creation
Quick How-To (Tool Creation)
Defining a tool is easy. Simply follow these steps.
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1. Clicking the Tool List button in the Command palette will open the Tool List.
2. Double-click a tile in the Tool List.
3. Select the tool type from the matrix of buttons.
4. Define the tool’s size through text entry or pull-down menus.
5. Specify tool orientation.
6. Specify Tool Stick out of Holder and Cutter Compensation.
7. Select the tool's material from the dropdown menu.
8. Select Spindle direction.
9. Add a comment if required.
10. Close the dialog or double-click on another tile (empty or full) to save the tool.

Tool Creation Dialogs
By double-clicking in an empty tile a new tool is created and a Tool dialog opens. A tool is then
fully defined within the tool window. This includes, but is not limited to, the type of tool and its size
and material. Only one Tool window may be open at a time. The Tool dialog can be re-sized by
clicking and dragging on the margin.
All Tool Creation dialogs have common elements, including a matrix of tool types, a graphic of the
tool, a method to specify the tool’s dimensions and material, spindle direction and offset settings.

37

Using the System

Additionally, all of the Tool dialogs have a Comment box. This comment will be output in the finished
code at the beginning of every operation that uses the tool. An example of each of the various Tool
Creation dialogs follows.

1. Tool Type
2. Tool Diagram
3. Holder Diagram
4. Holder Specifications
5. Length out of holder
6. Tool length offset #
7. CRC Offset #
8. Tool Material
9. Tool ID #
10. Tool Comment

Mill Tool Creation dialog
The Turning Tool Creation dialog has numerous options to describe an insert. In addition to the
elements common to the Tool Creation dialogs, the Turning Tool dialog has a tab to switch back
and forth between mill and turning tools, and a diagram to specify the insert’s orientation. The Other
checkbox allows the user to set up a custom insert. For more information, see the "Tool Creation"
section of the Turning guide.
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1.
2.
3.
4.
5.
6.
7.

Tool Type
Insert Type
Insert Specifications
Insert Orientation
Tool Holder Definition
Tool Options
Tool Setup Data

Turning Tool Creation dialog
The Mill/Turn and Multi-Task Machining options slightly modify the Mill Tool dialog, adding several
elements from the Turning Tool dialog and a Tool Orientation Diagram. The Tool Orientation
Diagram allows the tool’s axis of approach as well as the face to be cut to be specified.
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1. Tool Type
2. Tool Orientation
3. Tool Setup data

Mill/Turn Tool Creation dialog

Tool List
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Tool Lists can contain both milling and turning tools at the same time. Each tool has a unique
graphic to help you quickly determine what each tool is. Clicking on another tile while a tool dialog is
open will close the current tool dialog, saving your changes.
The Tool List is accessed from the Tool button in the Command palette. The list can contain a
maximum of 999 tools per part. The tool tiles do not have to be contiguous; there can be empty
spaces between tiles.
To navigate through the Tool Tiles, click on any part of the Tool List to select it. Use Ctrl+the
mouse wheel to scroll through multiple tiles at a time. The Process and Operations Lists described
in the following sections can also be navigated in this manner. To index through the various tools
that have been created, click on the scroll arrows located at the top and bottom of the Tool List.
Tools can be reorganized in the list at any time, even after operations have been created, without
reprocessing the operations. To reorganize the order of tools, click once on the Tool tile to be
moved and drag it to an insertion point. The system will automatically adjust the operations to reflect
the change in tool order and number.
Tool specifications can be modified at any point during part creation. However, if operations have
been created using the tool, those operations must be reprocessed. To reprocess an operation,
double-click on the Operation tile in the Operation List, and click on the Redo button. The new tool
specifications will be incorporated into the new operation toolpath.

Dragging Multiple Tools
You can select multiple tools and drag the group to the Process List. The tools appear in the
Process List at the location you release the mouse button, whether the tiles are empty or already
contain machining functions. Any existing tools will be replaced. You can also insert the tools
between process tiles.
You can drag a tool or multiple tools to multiple process tiles.
To Select a Range of Tiles:
1. Select the first tile.
2. Hold down the Shift key and select the last tile in the range.
To Select Multiple Tiles:
1. Select the first tile.
2. Hold down the Ctrl key and select each tile you want to drag.
To Drag Multiple Tools to the Process List:
1. Select the tool tiles you want to drag. The tools are highlighted.
2. Drag the tools to the position in the Process List where you want the tools to appear and
release the mouse button. The top tile in the group will be inserted where the hand icon is
positioned and the mouse button released.
To Drag a Tool to Multiple Tiles in the Process List:
1. Select the process tiles you want to add the tool or tools. The process tiles are highlighted.
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2. Select the tool or tools you want to use.
3. Hold down the ALT key, drag the tool or tools to the selected process tiles, and release the
mouse button.
Tool List Context Menu
Right-click anywhere in the tool tile list to reveal this menu.

Move To:
You use the Move To option to move a tile to a specific position by
number or to move a tile to the last position in the list.
Find:
You use the Find option to locate a specific tile by number or jump to the
last tile. For operations, you can also search by tool number.

Sort tools
When selected, tools will be sorted by Tool Group and spaces will be inserted between tool groups.
Save Selected Tools
This option saves the selected (highlighted) tools as a *.tlst file. (Use Click, navigate up/down,
Shift-click, to highlight a block of tool tiles, Ctrl-click to highlight individual tool tiles.) This can also be
done from within the Tool Manager dialog. Navigate to your desired directory, to make it the default
directory for saving and loading tool lists. Enter a filename and click the Save button.
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Please note that in order to add tools to an existing file: Load the tool file, select all tools, including
the additional tools required, then resave the file, overwriting the old version. Tools can also be
deleted in a similar way.
Load Tools

1. Load Tool file
2. Load tools from ISCAR Tool
Advisor or other tool library
3. Search for Tool file

1. Tools can be loaded from a previously saved tool list *.tlst file. This is a list previously saved
using the Save Selected Tools option.
Saved Tool lists can be added to any part file using the Load tools command or alternatively tools
can be loaded into the process creation tool selection dialog as shown above.
2. Tools can be loaded from an ISCAR Tool Advisor or similar *.xml file.
3. Use the search facility to search for specific tool sizes within the existing tool tiles. Simply start
typing a tool size and select the exact size from the dropdown list.
Tool Manager:
For more information see Common Reference Guide.
Small/Large Icons
Choose the display size of all toolbar icons.
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Tool Manager
The Tool Manager provides an expanded view of the Tool List in a tabular format. Each column
contains a parameter type and each row contains a tool. The list is customizable and can be sorted,
saved and printed.
For more details on the manager capabilities see the Common Reference guide.

Process Creation
To create a Process, you need to select a Process type and a Tool.
The machining Palette displayed will vary depending on the MDD you have specified in the DCD
dialog.
A part that references a machine capable of Turning offers a Machining palette with Turning
Contouring, Roughing, Threading, and Drilling tiles.
A part that references a machine capable of Milling offers a Machining palette with Mill Drilling,
Contouring, Pocketing, and Threading tiles. If SolidSurfacer is installed on your system, the Mill
machining palette also offers a Surfacing tile and local stock definition buttons. If you have other
options, other controls also appear.

Turning Machining Palette and Mill Machining Palette

Note: The processes that appear on the palette depend on which product options are licensed and
active. They also vary according to the Machine Definition Document (MDD) associated with the
Machine type currently specified in the Document Control dialog.
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When the machine is capable of both milling and turning operations, its Machining palette has two
dropdown sections. These dropdowns display the Turning and Mill Machining options available for
the MDD in use, providing access to both types of machining in one palette.

Creating a Process
A process is defined by a tool and a machining function. To create a process, double-click a
Process Tile. Select a process Type from the options available for your machine. Then, select a
Tool to use. Hover over a tool icon to display more tool information to confirm you have the correct
tool.
If you already know which Tool you wish to use, you can drag its tool tile onto an empty Process Tile
and then choose the machining type.

1. Doubleclick an
empty
2. Choose a Process type.
Process
tile.

3. Choose a tool type.

The Process tile will now show the Machining type icon and the number of the tool selected.

Once these items are in place, the appropriate Process dialog will open. Clearance values, cut
depth, speeds and other items are filled out in the Process dialog. The actual Process dialog will
vary depending on the type of machining function chosen. Roughing, Contouring, Drilling,
Threading and Surfacing Process dialogs are different from each other, with many common
elements such as the Entry/Exit Diagram. For detailed information see the Mill and Turning guides.
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Lathe and Mill Process dialogs

Applying the Same Machining Function to Multiple
Processes
You can quickly apply the same machining function to multiple processes: The machining function is
applied to all selected process tiles, and a dialog opens for the first-selected process tile.
To apply the same machining function to multiple processes:
1. Select the process tiles you want to change.
2. ALT-double-click the machining tile you want to apply or ALT-drag the machining tile to the
Process List.

Clearing the Process List
You should delete or modify Process tiles that you used to create previous operations and before
you create a new set of operations. When you click the Do It or Redo button, all of the Process tiles in
the Process list are used to create operations, even if operations have already been created using
those tiles. You should delete the Process tiles after you create the operations to ensure that you do
not unintentionally create duplicate operations. Clicking the Clear button
Processes in the Process list.
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Process List

The Process List can contain a maximum of 99 Process tiles. The Process tiles do not have to be
contiguous; there can be empty spaces between tiles. Please note that multiple processes can be
created in the same list. Any combination of machining functions can be grouped as needed.
Once operations are created, the processes can be thrown away, because the information from the
process is stored in the Operation.

Multiple Process Programming
If the Process list contains more than one Process tile when you click the
button, multiple
operations are created. All these operations use the same geometry. When the finished operations
are placed in the Operations List, they are “linked.” When you double-click one operation, all
operations created with the same Process list are selected. This enables you to change the
geometry more easily. Linked operations can be moved around in the Process list without losing the
link. A typical use for multiple Processes is roughing and finishing the same shape with the same or
different tools.
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1.
2.
3.
4.

Drilling Processes
Roughing Process
Contouring Process
Threading Process

If multiple Process tiles of the same type are used in the same Process list, each tile is applied to the
selected geometry. For example, you can use three drilling processes to drill, tap, and counter-bore
the same points or circles. Three separate operations are created to perform each of these
functions.
When multiple Process tiles of different types are used in the same Process list, the effect of each
process changes, depending on the other processes in the Process list. If a drilling process is
combined with a roughing or contouring process, the drilling process drills entry holes for the other
process. If a contouring process is combined with a roughing process, the contouring process
performs a finish pass around the wall of all selected pockets and bosses.
When multiple operations are created from the same Process list, they are linked. Double-clicking
on a linked Operation tile selects all of the other operations created by the same Process list. The
Process list is rebuilt and the geometry is reselected. The link is preserved even if the operations
are reorganized in the Operations list.

Process List Context Menus
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Right-click the process list and select the item you want from the menu. In addition to Find and
Process Manager you can select:

Change Process/Tool
Change the Process Type or Tool used for the current process.
Open Tool
Opens the tool dialog of the current process.
Move To:
You use the Move To option to move a tile to a specific position by
number or to move a tile to the last position in the list.
Find:
You use the Find option to locate a specific tile by number or jump to the
last tile. For operations, you can also search by tool number.

Save/
Load Process File
Process lists can be saved to a .prc2 file for reuse.
Process Manager:
See Tool Manager .
Small/Large Icons
Choose the display size of all toolbar icons.

Process Manager
The Process Manager provides an expanded view of the Process List in a tabular format. Each
column contains a parameter type and each row contains a process. The list is customizable and
can be sorted, saved and printed.
For more details on the manager capabilities see the Common Reference Guide.

Operations
A single operation consists of toolpath, clearances, tool information, feeds & speeds, and coolant
choices. It is a visualization of G-code and will be used as the source of the G-code sent to a CNC.
Operations are made from a GibbsCAM process. A process is the combination of a tool and a
machining function (roughing, contouring, drilling) applied to geometry or solids. Processes are
used to specify all of the operation’s settings.
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1. The first step to creating operations is to have the part model defined along with a list of tools to
cut the part.
2. You then click on the Cam button
Operation Lists.

in the Command Toolbar to open the Process and

3. Double-click a process tile to create a Process. This will open a window where you can choose
a process type and then a suitable tool. Finally, a dialog will open to set the operation’s
parameters.
4. You then select the geometry or solid that is to be machined and click the Do It
button
above the process tile list. This will create the toolpath for an operation. Repeat this process
until the part is complete.
5. Finally run Cut Part Rendering to check the part.

1.
2.
3.
4.
5.
6.
7.
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Toolpath
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Parameters

The components of operations

Defining the Cut Shape
After you complete the Process dialog, you must define a cut shape. The cut shape is the geometry
to which the process is applied.
For contouring and roughing functions, you must select geometry to use as the cut shape for the
operation. For roughing operations, you must select at least one closed shape for pocketing or
stock shape for face milling. For engraving operations, you can select multiple shapes for the cut
shape.
For contouring operations where you are machining a single shape, the cut shape is defined with
Machining Markers.
Machining Markers indicate the portions of the geometry to use as the cut shape when creating a
toolpath. The markers appear when you select the geometry. Drag the machining markers to the
locations you want on the geometry. Machining Markers are not used for drilling and threading
functions.
For more detailed information see the "Machining Markers" section in your Mill or Turning Guide.
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Process becomes Operation
An operation is automatically created by entering the desired parameters in the Process
dialog, selecting the geometry or solid to be machined and then clicking the Do It button.
(The Do It button is available in the workspace in a translucent dialog, from the Title bar of the
Process dialog and also by right-clicking anywhere in the workspace.)
This will generate one or more operations and toolpath.

A process, selected geometry, and the results of clicking the Do It button.
Clicking the Do It button applies the processes defined in the list to the selected geometry, creating
as many operations as needed. Operation tiles are created and appear in the Operations List. A
pocket might contain an entry hole process followed by roughing, finishing and possibly back boring
in one process group.
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If any completed Operation tiles are highlighted in yellow, the Redo button is also available. If you
make changes to the information in the Process list, click the Redo button to replace the operations
in the list with the new operations.
Operations contain the finished toolpaths. A toolpath consists of the actual moves the tool will make.
The toolpath is based on the cut shape. The post processor uses the operation data to generate Gcode.
Be sure to deselect the Operations so that you do not make unintentional changes. To deselect
Operation tiles, select an empty tile location or an insertion point between locations.

Operations List

The Operations List and its context menu
The software will use the list of operations to generate the final program that is sent to the CNC
machine. Operation tiles can not be moved away from the Operation List. They can be sorted and
reordered. To edit an operation’s process information, double-click on the operation and it will be
loaded back to the Process List. Clicking the Redo button will update the changes.
There may be a maximum of 16,000 operations in a part. The Operation tiles do not have to be
contiguous; there may be empty spaces between tiles.
The Operation tiles have a contextual menu, accessed by right-clicking on a tile. The menu
contains a number of commands that can be applied to an operation or its toolpath. The normal
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Find and Move options are also included. Modifications may be made to the tile’s location in the list,
a search may be performed or changes may be made to the actual toolpath. This includes changing
speeds at specific points in the toolpath, accessing the tool used for the operation, converting the
toolpath to geometry and locking data in the operation. Locking data and changing specific
information about an operation can be accomplished using the Operation Data dialog. See
Operation Data.

Operation Tile Stacking
The Operations list offers four choices for organizing Op tiles:

1.
2.

Individual: Unstacked.

Process Mode: Consecutive operations are stacked
together if they originated from a single process and all
belong to the same flow.
3.
Process List: Consecutive operations are stacked
together if they originated from a group of processes to
machine the same geometry—and all belong to the same
flow.
4.
Manual: Allows you to create stacks of consecutive
operations that all belong to the same flow. Can include
blank tiles and operations on different spindles.

For more detailed information on Tile Stacking see the Common Reference guide.

Operation List Context Menu
The Operation List provides the following context menu for finding, managing, and modifying
operations :
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Operation tile context menu
Right-click anywhere in the operation list and select the functions you want from the menu.
You can select the following:

Operation Data:
Displays the Operation Data dialog. See Operation Data.
Utility Markers:
Displays the Utility Markers dialog and the toolpath for the current operation. You can edit various
position-dependent toolpath data. See "Utility Markers" in the Mill or Turning guides.
Open Tool:
Displays the tool dialog associated with that operation.
Operation To Geometry:
Converts the highlighted operation’s toolpath to geometry. This geometry can then be modified as
needed and a center cut contour operation can be applied to it. This applies to contouring, roughing
and surfacing operations. This may be useful for avoiding clamps and fixtures or editing a pocket or
profile’s toolpath for individual preferences.
Redo Selected Operations:
Selecting this option regenerates the toolpath for any selected (highlighted) operation.
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Redo All Operations:
Selecting this option regenerates the toolpath for all operations.
Move To:
You use the Move To option to move a tile to a specific position by
number or to move a tile to the last position in the list.

Find:
You use the Find option to locate a specific tile by number or jump to
the last tile. For operations, you can also search by tool number.

Sort Operations:
Reorganizes all operations in the Operations List by tool number and creation order, from lowest to
highest tool number. See “Sorting Operations” on page 62.
Please be aware that sorting operations can be risky. For example, you could potentially
tell the system to tap a hole before it is drilled. Please be sure to review the results of the
sort to ensure you get the results you want.

Operation Manager:
Displays the Operation Manager .
Small/Large Icons
Choose the display size of all toolbar icons.

Operation Manager
The Operation Manager provides an expanded view of the Operation List in a tabular format. Each
column contains a parameter type and each row contains an operation. The list is customizable and
can be sorted, saved, and printed.
For more details on the manager capabilities see the Common Reference guide.
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Operation Data
You can edit various operation specifications in the Operation Data dialog. Right-click an operation in
the operation tile list to do this. You can change and lock values in the Operation Data dialog when
multiple operations are created from a single Process tile. You can change certain specifications for
one operation without changing them for all the operations that were created with the same
Process tile. In Milling, for example, if multiple pockets are machined from one Process tile, a
separate operation is created for each pocket. If an Entry or Exit Clearance Plane needs to be
changed to avoid a clamp between two of the pockets, you can change the clearance values in the
Operation Data dialog for one of the operations. The clearance values of the other roughing
operations are not affected.
You can specify a custom path for tool approach and retract. This allows you to determine tool
locations to avoid interference between tool and stock for such operations as back boring, milling
with right-angle heads, and ID or OD turning.
Please Note: This feature requires a post upgrade. To request a post upgrade, contact your
Reseller or the Gibbs Post Department.

Checking the Adv. Approach/Retract checkbox reveals
the Advanced Approach Retract dialog, allowing you to
select a custom approach and/or a custom retract.

You can also specify that the retract path reverses the approach path. When you click either of the
Select buttons, a dialog prompts you to define a path by selecting it in the workspace. Clicking Apply
sets that path as the custom approach or retract, before the tool moves to the operations’ Entry
Clearance value.
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Mill dialog

Turning dialog

The Operation Data dialog also allows for overrides of certain items such as speeds and entry/exit
settings. More importantly is text that can be output in the G-code that is operation-specific and the
ability to lock values by clicking on the padlock icons. If the part is opened on another machine with
different speed and feed data, the original settings will not be unintentionally overwritten. Unlocking
these settings will allow changes to the operation. For additional information, see Mill and Turning
guides.
Mori Seiki (and others) have the capability for performing turning operations that use a mill-like tool
that spins. In order to mark an operation as being a mill op but with the part turning (for turning
machines, millturns, and MTM), enter spinning_mill in the Op Comment section of the Operation
Data dialog. This will also ensure that the part will be rendered correctly and is also a requirement
for Post Processing.

Lock button:
Locked items ( ) retain the values entered in this dialog even if the operation is reprocessed.
Unlocked items ( ) return to their original values if the operation is reprocessed. Changes that
affect the toolpath appear in the toolpath drawing and the rendered image. The information in the
process tile that created the operation is modified to reflect the changes made in this
dialog. If an operation contains one or more locked values, a small lock symbol appears
on the Operation Tile.
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To lock or unlock a value:
Click the graphical button next to the right of the control to toggle its state between “locked”( ) or
“unlocked”( ).
Rotate button:
Click the Rotate button to set rotate options.

Program Stop:
The Program Stop checkbox is only available in the Operation Data dialog. If selected, a program
stop command is added at the end of the operation in the posted output. The default position is off.
Op Comment:
Information entered in the Op Comment text box appears in the posted output before the selected
operation it refers to. You can also enter Utility Data in this dialog.
At Op Start and At Op End:
You can use these text boxes to pass custom commands that trigger actions inside the post
processor. The list of custom commands and their actions should be supplied to you with the
documentation for your custom post.
Also, in these text boxes, any text string enclosed between simple straight quotes (either "..." or '...')
will appear as a text string in the posted output. Other types of quotemarks, such as “ ” ‘ ’ « » 「 」
『 』, do NOT act as text delimiters. In the posted output, each such quoted text string is inserted on a
new line.
If utility data is entered in the Utility Data At Op Start text box, then a small square appears on the
Operation tile in the upper left hand corner. If utility data is entered in the Utility Data At Op End text
box, then a small square appears in the lower left hand corner of the Operation tile. If operations
contain locked values, then a small lock symbol appears on the Operation tile.
1. Contains At Op Start data
2. Contains locked values
3. Contains At Op End data
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Operation Modifiers
When you change an operation by means of a plug-in, such as Transform Toolpath or HSM > Change
Feeds and Speeds , the change is lost when the operation is regenerated. Operation Modifiers are
slightly different, because they let you preserve the instructions you provide for changing toolpath.
Each time the operation is regenerated by Redo, all operation modifiers are re-applied.

Using Operation Modifiers
Right-click an operation and choose Operation Modifiers, the Manage Modifiers dialog presents a list
of operation modifiers. The left pane shows all modifiers available for the operation type; the right
pane shows all that have been assigned to the selected operation.
Each time you add a modifier, its modifier dialog appears. The parameter settings for most modifier
dialogs are the same as for the corresponding plug-in, except for the omission of controls for
selecting operations or creating new operations. You can add multiple instances of some modifiers,
such as Change Feeds and Speeds. Others, such as 5-Axis Toolpath Conversion, can be added only
once.
In the list of assigned modifiers, you can change the order in which they are applied, and you can
disable or enable one or more modifiers. Click the Edit button (or double-click the modifier) to
view or edit parameter settings.
When you click Do It, the operation is modified: The operation tile is marked with a plus sign (+) in its
lower left corner, and the corresponding toolpath is regenerated.
You can combine multiple Operation Modifiers, but you need to exercise caution applying two (or
more) modifiers that both change toolpath. The general guideline is: Use common sense. Some
specific caveats are noted below.

Notes for Using Operation Modifiers
l

For detailed information on any particular operation modifier, see the Plug-Ins guide.
Operation modifiers are like plug-ins in most respects, except that they persist and are reapplied each time the operation is regenerated.
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l

l

l

l

l

Operation modifier data is stored with each operation, not with the process or process group.
For example, if a process group is associated with three operations, applying a modifier to
the second operation has no effect on the first or third.
You cannot save modifiers independently of the operation. You cannot copy or transfer
modifiers from one operation to another.
Modifiers are applied sequentially, without inter-modifier communication: The ending state of
modifier n is the starting state of modifier n+1. Therefore, the toolpath could change
significantly if the same set of modifiers were to be stacked in a different order.
Clicking CAM palette button Redo preserves existing modifiers, but clicking CAM palette
button Do It does not; it creates one or more new operations without copying modifiers.
Do not combine a conversion modifier (such as 5-Axis Toolpath Conversion or Convert to
Trochoidal) with any other modifier, except to follow it with Change Feeds and Speeds or
Transform Toolpath.

Modifying Operations
Changes can be made to Operations in the following ways:
To recreate operation Processes:
Double-click the Operation tile in the Operations List. The Process tiles are recreated. Geometry is
selected and any machining markers are repositioned as they were when the operation was
processed. Any operations created from the same Process List as the selected operation are
selected.
To replace selected operations:
1. In the Operation List, double-click the operation you want to replace.
The operation tiles associated with the operation highlight and the corresponding processes
appear in the Process List.
2. In the process List, double-click the tile for the process you want to change.
The Process dialog appears.
3. Type the information or select the option you want to change.

4. Click the Redo

button. Selected operations are replaced with the modified operations.

This is useful when multiple operations are created from a single Process tile, because you can
make changes to one operation without changing the other operations created from the same
process. For more information, see Operations List.
To change an operation:
1. Right-click the Operation tile and select

Operation Data.
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2. Change or lock values, such as clearance planes and feeds and speeds.
3. Close the Operations dialog
To reprocess all operations in a part file:
From the Edit menu, select Redo All Ops
. The system recalculates all of the toolpaths, and
positioning moves based on the new order of operations.
To reorganize operations by tool number and creation order:

Select Sort

. The operations sort by tool number and creation order.

You can also manually rearrange the Operation List by moving tiles to different locations in the list.
The order of machining in the finished NC program corresponds to the order of the operations in the
Operation List. Therefore, the order of Operation tiles in the Operation List is very important.
Efficient use of multiple process programming may produce operations in a less-than-optimal
machining order. You can reorganize the Operation List to create a more optimal machining order.
However, consider the following when reordering operations. When using the Auto Clearance option
or the Material Only option, the system takes into account the material conditions when it creates the
positioning moves and toolpath for each operation.
Changing the order of operations can change the initial material conditions for existing operations. If
you change the order of operations, add operations, or remove operations from the list, be sure to
check the toolpaths and positioning moves. Render the part to check for tool interference,
unnecessary moves, or incorrect positioning moves. If adjustments are necessary, you must
reprocess the operations.
Reprocessing all operations in a part file is very easy using the Redo All Ops item under the Edit
menu. When the operations are reprocessed, the system recalculates all of the toolpaths and
positioning moves based on the new order of operations.

Sorting Operations
To sort operations:
Right-click a tile in the Operations List or a row in the Operation report and select Sort Operations.
The Sort Operations function reorganizes all operations in the Operations List. Sorting first looks at
CS's and splits the Operations within the CS block. It then reorganizes the operations by tool
number and creation order, from lowest to highest tool number. Next it looks at the following block
of Operations on the same CS, etc. The system examines all the operations and tries to group them
by tool number to minimize the number of tool changes. Any blank spaces in the Operations List are
removed.
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Before Sort

After Sort

Operations created in a Process Group (a group of processes to machine the same geometry) are
sorted based on their order in the Process List when they were created. For example, finishing
operations are not placed before the roughing operations in a Process List. You can manually
reorganize operations by dragging them to the location you want in the Operations List. The order
of machining in the finished NC program is the same as in the Operations List. Therefore, the order
of tiles in the Operations List is very important. You can organize operations anytime during the
programming of the part.
Please be aware that sorting operations can be risky. For example, you could potentially
tell the system to tap a hole before it is drilled. Please be sure to review the results of the
sort to ensure you get the results you want.
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Multi-Level Sort
Selecting the Multi-Level Sort… command opens a dialog where you can select up to four columns
you want to use as sort criteria. Check the Ascending checkbox to sort in ascending order,
unchecked will sort in descending order.

Printing the Toolpath

After an operation has been created, the resulting toolpath can be printed. The Printing Preferences
section of the Preferences>Display Tab specifies how the system will handle the background color
and line contrast. You can choose to print black and white, full color or color on a white background.
When the desired toolpath is on the screen, choose Drawing from the Peripherals sub-menu in the
File Main menu dropdown.

Cut Part Rendering
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Cut Part Rendering is the process of running a visual inspection of the operations you’ve created.
Rendering steps through each operation, displaying the movement made by each tool as it cuts the
part. Once you have one or more operations you can render the part for a visual inspection. This
can be very helpful in catching any errors in the toolpath. Rendering is accessed by clicking the Sim
button in the Command Toolbar. For more information on CPR see the section on Rendering in the
Common Reference guide.

Post Processing
After operations to machine the part are created and verified, the file needs to be post processed.
Post Processing creates a text file (NC Program) that can be transferred to the machine control,
from a part file (a VNC file). Post Processors specific to particular machine controls are used to
create the text file from the VNC file. This is all accomplished in the Post Processor dialog. The Post
Processor dialog is accessed by clicking on the Post Processor button in the Commands palette.
Posting a part is very easy. Once the dialog is open, simply select a Post Processor to use, give the
posted G-Code a name, set any parameters desired and click on Process. Once the G-code is
written, you can send the output to the control.
1.
2.
3.
4.
5.
6.

Post Processor Selection
Program Name
Communications
Text Window
Output
Multiple Parts

The Post Processor dialog
Use the File > Preferences > G-Code Editor Settings screen to set which Editor you will be using to edit
your output files. For more details, see the Common Reference guide.

Posting Step-By-Step
After operations to machine the part are created and verified, the file needs to be post processed.
Post Processing creates a text file (NC Program) that can be transferred to the machine control
from a part file (a VNC file). Post Processors specific to particular machine controls are used to
create the text file from the VNC file. This is all accomplished in the Post Processor dialog. The
Post Processor dialog is accessed by clicking on the Post Processor command button in the
Commands palette.
Posting a part is very easy. Once the dialog is open, simply select a Post Processor to use, give the
posted G-Code a name, set any parameters desired and click on Process. Once the G-code is
written, you can send the output to the control.
The following will walk you through Post Processing a part file.
1. The first time you use a version of GibbsCAM, you should set your posting preferences. The
Post Processor Comments preference tab allows you to specify comment data that is output in the
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NCF file generated by the system. If an item is checked, that data will be output. This dialog can
be found in the File menu under
Preferences . This only needs to be done the first time you
use a version, but you can change it for each program if that is your choice.

You should also at this time set your G-Code Editor Settings and Com Set-Up Preferences.

2. Click the Post Processing command from the Command Toolbar

3.

Select a Post Processor.
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Clicking on the Post Processor Selection button will open the Select Post Processor dialog.
Navigate to where you keep your Post Processors, select the file and click Open. This defines
the post selection for the part.

4.

Name the program.
Clicking on the Program Name button will open the Save NC File dialog. Navigate to where
you keep your posted output files, name the file and click Save. This creates an .NCF file for the
code that is to be generated.

5. Set any desired output options.
There are a number of options you may set in the Options and Part Duplication sections of the
Post Processor dialog. For more details see the Mill Guide.
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6.

Open the Text window.
If you have not specified a Post Editor to use for the output from the Preferences menu and you
want to view the code, open the Text window by clicking the Text window button. This opens a
fly-out window to the side which is designed to view the posted code as it is being generated.
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7.

Click Process.
Clicking the Process button will generate the code which will be sent to the control. If you have
selected a Custom Application from the Preferences menu, the code will be displayed in the
application after it is generated. This may take a few minutes for large programs, so do not be
surprised if the application does not open immediately.

8.

Save the file.
Once the code is generated, save the file, either by clicking Save or by using the Save option from
the File menu of the Post Editor application you have selected.

9.

Send the file to the control.
Once the code is generated you may send the NCF file to the control. Click the File >
Communication
command to open the Communication window. The name of the NCF file
you have saved should be visible next to the Program button. Click Send to send the posted
output to the control.

1.
2.
3.
4.
5.
6.

Send File
Receive File
Program Selection
Control Selection
Send/Receive/Stop
Progress Bar
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Communications
The system contains integrated communications. Third party communications packages can also
be used to communicate with CNC machines. Before data can be sent to the CNC machine, the
communication parameters need to be set up. To access the Com Set-Up tab choose File >
Preferences .

This dialog is used to set up communication protocols needed for sending a file to
a control or receiving a file from the control. Different controls have different protocols (parameters).
Refer to the machine control manual for the necessary protocol specifications.
•

Protocols

•

Communicating with a CNC

Protocols
Adding
To add a new protocol, type a new name and change the settings for the machine. Click the Add
button. The name will appear in the list.

Changing

To change a protocol, select it from the protocol list and modify the information. The changes are
automatically saved.
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Removing
To remove a protocol, select the protocol from the list and click the Remove button.

Communicating with a CNC
To send a file to or receive a file from a CNC machine, click the Communication button in the Post
Processor dialog.

Communication dialog
The File > Communication dialog is used to send or receive files to and from a CNC. You may define
the File type for the transmission, either a post (ASCII) or part file (binary).

1.
2.
3.
4.
5.

Send Mode
Receive Mode
Program Name
Protocol Menu
Progress Bar

Sending a File to the Control
To send a file to the control: Ensure the Send Mode is on, choose the protocol, choose the file with
the Program Name button and click Send. Click the Stop button to cancel. The Progress Bar
indicates the status of the transmission.
Receiving a File from the Control
To receive a file from the control, open the Communication dialog from the Post Processor dialog or
from the File menu. The Receive Mode button should be depressed. Choose the correct protocol
from the Protocol pop-up menu. The name of the received program is specified by clicking on the
Program Name button. When everything is set correctly, click on the Receive button, and then send
the program from the control. If the Text Window is open from the Post Processor dialog, the
program will scroll by as it is received.
It is recommended that edited NCF files received back from the machine control be saved
under a different name than the original NCF file that was initially sent to the control. That
way if the original VNC file is reprocessed, it won't affect the edited NCF file. For
example, a part file named SAMPLE.VNC is post processed and a text file named

71

Communications

SAMPLE.NCF is created. Changes are made to the program at the machine control and
the new file containing those changes is sent back and received at the offline computer,
but under the name SAMPLE1.NCF. If SAMPLE.VNC is reprocessed again at a later
date, it won't destroy the SAMPLE1.NCF file that contains the changes that were made
at the machine.
Sending Other .NCF Files
Any text file that matches the extension set in the Post text box in the File Extensions Preference can
be sent to the control. Refer to the Post Processing chapter for more information on output file
extensions.
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Conventions
GibbsCAM documentation uses two special fonts to represent screen text and keystrokes or
mouse actions. Other conventions in text and graphics are used to allow quick skimming, to
suppress irrelevancy, or to indicate links.

Text
Screen text. Text with this appearance indicates text that appears in GibbsCAM or on your monitor.

Typically this is a button or text for a dialog.
Keystroke/Mouse. Text with this appearance indicates a keystroke or mouse action, such as
Ctrl+C or right-click.
Code. Text with this appearance indicates computer code, such as lines in a macro or a block of
G-code.

Graphics
Some graphics are altered so as to de-emphasize irrelevant information. A “torn” edge signifies an
intentional omission. Portions of a graphic might be blurred or dimmed to highlight the item being
discussed. For example:

Annotations on a graphic are usually numbered callouts (as seen above), and sometimes include
green circles, arrows, or tie-lines to focus attention on a particular portion of the graphic.
Faint green borders that outline areas within a graphic usually signify an image map. In online help
or a PDF viewer, you can click a green-bordered area to follow the link.
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Links to Online Resources
Link
Go

URL

Action / Description

http://www.GibbsCAM.com

Opens the main website for GibbsCAM.

Go

https://online.gibbscam.com

Opens a restricted website containing
materials available for download. Requires a
GibbsCAM Online Services account; to set
up an account, contact GibbsCAM Support.

Go

https://store.GibbsCAM.com

Opens the website for the GibbsCAM
Student Store.

https://GibbsCAMMacroWiki.3DSystems.com

Opens a wiki containing documentation and
examples of GibbsCAM macros. Requires a
GibbsCAM account.

http://kb01.GibbsCAM.com

Opens a Knowledge Base article, Contour
Operations Using Thread Mill Tools, that
explains in detail the correct way to program
Contour processes using Thread Mill tools.

Go

mailto:GibbsCAM.Support@3DSystems.com

Runs your email client to create a new
message addressed to the 3D Systems
Technical Support department for
GibbsCAM.

Go

mailto:GibbsCAM.Registration@3DSystems.com

Runs your email client to create a new
message addressed to the 3D Systems
Registration department for GibbsCAM.

Go

mailto:GibbsCAM.Sales@3DSystems.com

Runs your email client to create a new
message addressed to the 3D Systems
Sales department for GibbsCAM.

Go

http://www.autodesk.com/inventor

Opens an external website that provides
more information on Autodesk Inventor
products.

http://www.celeritive.com

Opens an external website that provides
more information on VoluMill Ultra HighPerformance Toolpath (UHPT) from
Celeritive Technologies.

http://www.predator-software.com

Opens an external website that provides
more information on a CNC editor and a
virtual CNC viewer from Predator Software,
Inc.

Go

Go

Go

Go
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Glossary
This glossary is intended to provide clarifications on terms and their usage throughout the
GibbsCAM guides. Some of the terms may, at first glance, appear common to the industry, but
many have specific meaning to GibbsCAM products.
2.5D Solids

The 2.5D Solids module allows you to import and modify or create solid
models. The models can be pocketed and contoured without the use of
geometry.

Advanced CS

The Advanced CS module extends the capabilities of the Production Mill
module. Advanced CS provides for the creation of multiple coordinate systems
for creating and machining geometry. Capabilities include 3D geometry, 4thaxis and 5th-axis rotary positioning, tombstone machining, and/or work fixture
offsets.

Body

A body is a term used for solid and sheet objects created by the system Each
body is a single object composed of faces and the area enclosed by the faces.
Bodies are used as the building blocks for creating part models.

Closed Shape
Coordinate
System

Edge
Face

A closed shape is a set of geometry that does not have a discernible start or
end point. The shape is a loop.
A coordinate system (CS) is a plane in space with an origin and three axes.
The axes are the horizontal, vertical, and depth axes. The standard coordinate
system is the XY plane (milling) or the ZX plane (turning). The XY plane’s axes
are the X (horizontal) axis, the Y (vertical) axis, and the Z (depth) axis. Other
standard coordinate systems are the XZ and YZ planes. Non-standard CSs
are defined using horizontal, vertical, and depth axes, labeled as HVD.
An edge is a curve or line between two faces. A body must have two faces
connected at every edge.
A face is one surface of a body or sheet. Faces are surfaces that have
knowledge of the surfaces that surround them. For example, one side of a
cube would be considered a face. Each face is bounded by loops. A simple
face is surrounded by one loop.

Geometry
Expert

Geometry Expert is a means of creating connected geometry through an
interface that is similar to a spreadsheet.

Half Point

Term referring to entering a value for a single axis (X, Y, Z, etc.) when creating
geometry using Geometry Expert. Geometry Expert may only need the
dimension of a single axis to create a feature due to existing tangencies.
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List

GibbsCAMsoftware presents three lists: Tool List, Process List, and Operation
List. The Tool List contains all of the tools used to machine the current part. The
Process List contains temporary data that is used to define operations. The
Operation List contains final operations that machine a part.

Loop

A loop is a series of connected edges that outline a face.

Machining
Markers

Machining Markers are used when creating mill contour or turning operations.
The Machining Markers specify start and end points, climb or conventional
cutting, and the side of the geometry to cut.

MDD
(Machining
Definition
Document)

In GibbsCAM terminology, the MDD (Machine Definition Document) is where
all aspects of a particular machine are organized and stored, including its linear
and rotary axes, its toolgroups, spindles (part stations), and utility stations, and
how these are associated and organized into Flow Axis Sets, Interop Moves,
etc. It also specifies the post processors, coolants, extended cycles, and
simulation bodies available to the machine, and it records preferences for work
areas, limits, clearances, and many other items.
Each item in the Document Control dialog’s Machine Type menu is a separate
MDD. MDDs include 3-axis, 4-axis, or 5-axis mills, 2-axis or 3-axis lathes, Wire
EDM machines, and others.

Modeling

Multi-Task
Machining
Open Shape

Origin
Production

Modeling is the process of defining a part’s shape and dimensions on a
computer. Common types of modeling include wireframe modeling (both 2D
and 3D), surface modeling, and solid modeling. Solid Modeling is the method
of defining a part as a solid object rather than as a wireframe or collection of
surfaces.
The Multi-Task Machining (MTM) module extends the capabilities of the
Production Turning module. MTM supports programming machines with
multiple spindles and multiple turrets.
An open shape is a set of geometry that is not fully connected. There is a
definite start point and end point to the shape. The open shape may or may not
be terminated.
The origin is the center of a coordinate system. The origin’s location is H0, V0,
D0. It is where the axes meet.
Production refers to basic 2D GibbsCAM functionality, generally on a module
basis. For example, both the Mill and Turning modules are Production
modules. Additionally, the Geometry Creation guide would be referred to as a
Production guide.

Sheet

A sheet is the term used for surfaces created or imported by the system. A
sheet is an object composed of faces, but a sheet has no volume or thickness.
It is only composed of its own faces.

Solids Import

Solids Import is a module that allows a user to import a solid model and
perform simple modifications to the model, including geometry extraction. All
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machining operations are performed upon extracted geometry.
SolidSurfacer

Tile

SolidSurfacer is the segment of the GibbsCAM product that provides 3D solid
model creation and the direct machining of 3D solids and sheets. The
SolidSurfacer module requires the Advanced CS module.
A tile is an entry in a list. There are Tool tiles, Process tiles and Operation tiles.
Double-click a tile to access its contents or set its parameters.

Utility Markers

Utility Markers are manual overrides of the feedrates and other facets of
operations. Typically they are used to lower the feedrate when entering a
corner and speed up again once leaving a corner.

Vertex

A vertex is the common endpoint of two edges.

Workgroup

A workgroup can be thought of as a layer that separates groups of geometry.
This helps keep the Workspace uncluttered. Workgroups can also be used to
define custom stock based on the geometry in them.
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